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C O M M A N D. C O M
Attendance at the
January general meeting:
51 members and guests.

To Contact CIPCUG
The Outer Edge......................805-485-7121
General Information………...805-289-3960
Mailing Address...P.O. Box 51354, Oxnard, CA
93031-1354
On the Web: cipcug.org
On Facebook: Facebook.com/groups/cipcug

Nonprofit agency seeks
computer helpers
Volunteers with a passion for people and
some computer skills are being sought by a
Newbury Park nonprofit, Paradox, which has
the goal of “bridging the digital divide by providing cost-effective, reliable computers for
low-income families and nonprofit organizations.”
Robert D. Phillips, president and CEO of
Paradox, discussed his efforts at the January
meeting. He can be reached at 805-208-1984
or at robert.phillips@paradoxct.org for more
information about the project and the skills
needed. The website is www.paradoxct.org.
Because of the work involved, Phillips
said, he can’t provide lots of training for volunteers but will walk them through what is
needed. His presentation made it sound like the
volunteers would be more involved in software
than hardware.

By Jim Brown, President

H

ello, everybody.
We are now in the month of February, and one of the holidays
that we celebrate is Valentine’s Day — a day devoted to the
higher ideal of love and respecting the higher qualities of our
inner spirit. You might wonder why I am beginning this column with those
words. I felt that I should begin this writing this evening because an issue
was brought to the attention of your board after the last meeting.
A member of our group alerted the board about a section in the book we
have been promoting — “Secret Guide to Computers” contains a section entitled “Tricky Living.” It is the “Tricky Living” section that troubled our
member. The section also troubled our board members. This
section of the book contains material that some may find troublesome. The author writes about subjects that do not have
anything to do with computers. In reading this section, I believe the author (who is also the publisher) has written information, expressed opinions, and included jokes, many of
which I have already seen in emails sent to me. Here I believe
Brown
the author is an equal opportunity offender. It is as though he
has seen so much of emails, etc. that he has become desensitized to the possible feelings of others. The conclusion is that this section
does not belong in the guide. If he wanted to create a joke book or express
ideas, fine, but this section does not belong in this book.
We have utilized this guide in the past for a number of reasons: It contains useful information on computers; other computer associations have recommended the book and we have seen it as a benefit for our members, and
finally we used the book as a fundraising device for our treasury. We did not
suspect that anything would be different with this edition of the guide.
Our response is to apologize to any of you who find the section “Tricky
Living” troublesome. It is my hope that you can ignore that section. Secondly, we will contact the author and advise him of our feelings and suggest
that in the future he writes about the subject of his guide — in this case, computers. We will also write to our larger regional computer associations and
advise them of our concerns.
I hope that you might relate instead to my opening words in this column
(Continued on page 5)
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Coming events

No program confirmed by deadline forTOE
Programs
No program had been confirmed by
the deadline for this month’s TOE, so be
sure to check the CIPCUG website closer
to the meeting date for the latest details.
The February meeting starts at 8:45 a.m.
on Feb. 25 in the Camarillo Boys & Girls
Club, 1500 Temple Ave. (Ponderosa
Drive and Temple Avenue), Camarillo.
(See the map on the last page.)
The doors open at 8 a.m. The Internet
and Networking SIG and the Social Media SIG will start at 8:45 a.m.
Other meeting dates for this year:
March 24
April 28: Avast
May 26: Abby Stokes, author of “Is
This Thing On?”
June 23
July 28
Aug. 25
Sept. 22
Oct. 27
Nov. 17 (third Saturday)
Dec. 15 (third Saturday)
SIGs
The Special Interest Groups (SIGs)
are sponsored by CIPCUG and led by
volunteer club members. They are free to
CIPCUG members.
Other than those presented during or
just after the regular meeting, the SIGs
run from 6:30 to 8:30 p.m. at Ventura

Door prizes

The club gets 10 percent of the sales
price. Sold items must be picked up at
the end of the day’s meeting.
Any items not picked up will become
the property of CIPCUG and will be
subject to disposal at the club’s
discretion.
CIPCUG is not responsible in any
way for items bought or sold at the table.
Each item is sold as-is unless otherwise
stated.

We have two types of raffle tickets:
one for prizes offered by the presenter
and one for club-provided prizes. The
tickets for the presenter’s prizes are free
and limited to one per member.
The tickets for the club-provided
prizes are $1 each, $5 for six tickets, $10
for 13 tickets, $15 for 20 tickets and $20
for 27 tickets and are available to
anyone. Those who can’t stay until the
drawing may sign their tickets and give
the person selling the tickets a list of the Meeting, SIG notices
If you would like e-mail notices of
prizes they would like in the order they’d
pick them. Winners’ prizes will be held regular meetings and SIGs, go to
www.cipcug.org, where you’ll find a link
until the next meeting.
on the home page to sign up. The URL is
Consignment table
cipcug.org/listserv.cfm.
A consignment table is set up at every
You will need your membership
meeting. Anyone can buy, but only number, which is on the back cover of
members can sell.
TOE, to complete the sign-up.

County Computers, 2175 Goodyear Ave.,
Unit 117, Ventura; phone 289-3960.
From the 101 Freeway, exit at Telephone,
take Telephone south to McGrath, turn
left and go one block. Turn right on
Goodyear and right again into the second
driveway. Unit 117 is the back, right
corner of the building. The pre-meeting
SIGs are at 8:45 a.m. at the Boys & Girls
Club. The after-meeting SIG is at locations to be announced on the meeting day.

The general schedule:
Fourth Tuesday: Linux.
Fourth Saturday (or the regular
meeting day): Social Media SIG (Jessica
Scott and Mark Maidel) and Internet and
connectivity SIG (Toby Scott), 8:45 a.m.
The location of Michael Shalkey’s aftermeeting SIG is announced at the meeting.
The February and March schedules
(Continued on page 4)

Minutes of the January meeting
By Diane Mortensen
The CIPCUG Board of Directors held
its monthly meeting on Jan. 28, 2012. In
attendance were Toby
Scott, Craig Ladd, John
Weigle, Art Lewis, and
Helen Long. Absent were
Jim Brown, and Diane
Mortensen.
Art presented the December 2011 treasurer’s Mortensen
report, which appears elsewhere in TOE. The board approved the
December 2011 treasurer’s report.
Craig informed the board that there
are many possible programs lined up, but

at this time, nothing definite is scheduled.
Toby has been working with the
Camarillo City Library regarding future
computer programs and other possibilities. He stated that the library could not
provide a storage area or confirmation of
dates. He believes that more communication is necessary.
The topic of plans for CIPCUG’s 25th
anniversary was discussed. Suggestions
were made and Jim Brown has begun
asking volunteers to work on the details.
A CIPCUG member asked to speak to
the Board on the book “Secret Guide to
Computers & Tricky Living.” There were
parts of the book in the section Tricky

Living that he felt were personally offensive and did not belong in a computer
book that was promoted by computer user
groups. After the board meeting, several
board members reviewed the book, in
particularly the sections the member
spoke about. Comments and suggestions
from those reviews will be discussed at
the next board meeting — in particular, if
and how to communicate to the author
and other computer user groups that also
promote the book about the author’s personal comments contained in the Tricky
Living section.
There being no additional business to
discuss the Board meeting adjourned.
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Social Media SIG, Q&A

Passwords, Windows Live and failed autofills
Reported by John Weigle
Internet, email, social media SIG
Because the Boys & Girls Club had to
set up for an event later in the day, we
had to use the auditorium as a single
room, so we the Social Media and Internet and connectivity SIGS were combined
this month. Unless otherwise noted, Toby
Scott answered questions and Jessica
Scott ran the computer. — Editor
Passwords in Firefox
Q: I have an incorrect password in
Firefox. How can I change it?
A: Go to Tools > Options > Passwords > Security > Saved Passwords,
where you can remove the incorrect password or all passwords if you decide you
don’t want any of them saved. Then go to
the site in question, use the correct password and ask Firefox to save it.
Windows Live preferences
Q: In Windows Live Mail, messages
keep downloading if we mess something
up. How can I change that?
A: Go to Start > All Programs > Windows Live Mail > Options > Mail Accounts > Properties > Advanced, and
check the box to remove from server
when deleted from deleted items.
Passwords not remembered in Firefox
Q: My password for my ISP’s spam
filter isn’t being remembered in Firefox.
A: I haven’t had that problem, but go
to Firefox > Tools > Options > Security
and check the saved passwords to see if
it’s there. You can’t add a password
manually. Also check exceptions to be
sure the site isn’t listed as one that’s supposed to forget the passwords.

This month’s Q&A topics:
Internet and Social Media SIG
Passwords in Firefox
Windows Live preferences
Passwords not remembered in
Firefox
Autofill fails
Java Script
Tablets
3G, 4G, Wi-Fi
Finding downloads
Users
Indexing USB drives
Music folder lists
From the audience: I’ve had the same
problem in Firefox and ended up switching to Chrome, which I didn’t really want
to do. So far I haven’t had the problem
with it.
Jessica Scott: Could it be a cache or
cookies setting?
Autofill fails
Q: The automatic completion feature
doesn’t always work on my browser.
Why not?
A: It’s a result of the HTML coding
on the site, not the browser. Autofill will
recognize field names like First name,
Name, Address and so on, but it can’t
perform autofill for names like Field1 and
Field2. Sometimes, but not always, the
browser will remember what goes in such
fields on your second visit.
Java Script
Q: I got an email with some pictures
attached and when I clicked on the file, it
said it needed Java Script to run it. How
do I enable it?

More on coming events ...
(Continued from page 3)

follow:
February
Saturday, Feb. 25: Regular meeting,
pre-meeting Social Media and Internet,
connectivity SIGs.
Tuesday, Feb. 28: Linux SIG. Topic:
We will explore the live version of Linux
Mint 12 and try to answer any questions.

March
Saturday, March 24: Regular meeting, pre-meeting Social Media and Internet SIGs.
Tuesday, March 27: Linux SIG.
Topic TBA.
Be sure to check the calendar on
cipcug.org for updates on event programs, dates and times.

Removing update files
Regular Q&A
Sharing printers
Missing DLL file
Printing from tablets
LPT ports
Moving programs from XP to 7
Public Wi-Fi
Router password
CCleaner
Computer slowing down
Updates and other installations
Showing file sizes
A: The best thing to do is save the file
to a folder and view it there. A lot of the
programs that automatically open attachments are turning the feature off because
of fears of viruses. People say it’s inconvenient, but how inconvenient is a virus?
If some security expert has decided
there’s enough danger in the feature to
turn it off, it’s a good idea not to try to
bypass it. Moving the file to a folder and
then opening it lets your anti-virus program scan it. If you just run it out of
email the anti-virus doesn’t have a chance
to scan it.
In addition to attachments, be especially careful about clicking on links in
email. We’re all aware of the websites
that appear to belong to banks or other
financial institutions but are really scams
to collect your login names and passwords so they can empty your accounts.
The link itself is not the virus, but when
you go to the site, it can install viruses or
grab your information as you type it in.
From the audience: And no bank will
ever send you email asking for your personal information.
Toby: But banks will sometimes send
you email with links to click on, and the
scammers are depending on people to
carelessly click on such links in the scam
emails.
Q: Is it safe to go to such sites and
leave nasty messages because you know
they’re phony?
A: I wouldn’t because you’re leaving
(Continued on page 5)
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traces, and the owners of the sites might
be able to track you down and possibly
launch denial of service attacks on your
machine.
From the audience: Some email programs let you hover your mouse over a
link in an email to show the full URL.
A: That’s true. But the basic rule is to
go to any financial site the way you normally do — by typing in the URL or using the link in your bookmarks or favorites. You can be sure that if there’s really
a problem with your account, it will show
up when you go to the page this way. And
I’m willing to wager that 99.999 percent
of the time, there’s not going to be any
security problem.
Tablets
Q: Can you tell me why anyone
should buy an iPad or any other tablet?
A: It’s a matter of how you want to —
or need to — access the Internet. Some
people need a desktop, some a laptop,
some a smartphone, some a tablet and
some a combination of one or more of the
above. There’s no one solution that fits
everyone.
For example, my laptop has a battery
life of about 2½ hours. The Thrive tablet I
bought from Staples after last month’s
program has a battery life of about 11
hours. That would have gotten me all the
way to Beijing when we went to China;
my laptop couldn’t get me to Hawaii. The
tablet will fit in a woman’s purse,
whereas I had to have a separate carry-on
bag for the laptop. Some tablets have
phone access, and if you travel a lot, that
can be useful. It isn’t that anybody ought
to have anything. You have to decide
what you need based on you lifestyle,
physical transactions and what works best
for you. There’s no universal solution for
all people.
The decision is similar to picking a
vehicle. Do you need a van, an SUV, a
limousine or a sports car? I can tell you
what a pickup does, but I can’t tell you
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that it’s the right vehicle for you. That’s
determined by your needs.
3G, 4G, Wi-Fi
Q: Can you describe the differences
between 3G, 4G and Wi-Fi?
A: 3G and 4G are phone connections.
They’re automatically encrypted and can
be used for GPS devices and are extremely portable. They can be hacked, but
it’s very difficult. They can be used while
driving down the freeway — if you’re a
passenger, of course. They’re very handy
and very portable.
Wi-Fi is a broadcasted signal you can
pick up and use. We create a Wi-Fi spot
here for our meetings by putting in a
router that’s connected to the Internet and
connecting to it. If you want to use it, just
ask us for the code. You can also find WiFi spots at Barnes & Noble and Starbucks, among many other places. You
can’t use Wi-Fi while driving down the
freeway because of its limited range. The
3G and 4G cover wide areas.
The differences between 3G and 4G
are speed, along with some advanced
security features in 4G. Generally, Wi-Fi
is much faster than either 3G or 4G, but
this won’t be the case if you have extremely slow DSL service. Basically, you
can’t get unlimited data download contracts anymore, although some people are
grandfathered in. Providers will slow you
down and at some point will raise the cost
considerably if you go over the data limit
in the contract. Wi-Fi downloads are not
being limited by anyone I know of. If you
get a message that you’re asking for a
very large file and offered the chance to
wait for a Wi-Fi connection, it’s a good
idea. In some hillside areas of the county
you can get only a slow speed DSL.
Finding downloads
Q: How can I find my downloads? I
have several newsletters that I get by
email. I save them and I see a list of
downloads, but I don’t know how to get
to them.
A: Hold down the Windows key and

Page 5
the E key to open Windows Explorer (not
Internet Explorer; the two programs are
entirely different despite the similarity in
names) to search for the Downloads
folder. Later versions of Windows create
one automatically, but if you don’t have
one you can create it and then set up your
browsers to put downloads there.
If you want to create a shortcut to
your Downloads folder in XP, Vista or
Windows 7, right click on the folder and
then click on Send to, select Desktop
(create shortcut) which will create a
shortcut on your desktop. You can then
drag it to your taskbar if you prefer it
there. In Vista and Windows 7, you can
also place the current location in your list
of Favorites in Windows Explorer by
opening the folder you want to add, rightclicking on Favorites and selecting Add
current location to Favorites. You can pin
anything you want to there.
You can do the same thing with libraries, which are collections of shortcuts
to data. Right click on documents and you
can put any folder you want in a documents library. The Favorites list is a oneclick wonder to a single folder. The libraries are for the total hierarchy; i.e., if
you put My Photos in the library, it shows
all the subfolders.
Users
Q: If you foolishly set up your computer with users, do you get a Downloads
folder for each user?
A: First, let’s address “foolishly.” If
you eliminate all the users on your computer, you make it unbootable. Windows
operates with users and user permissions
to determine who can do such things as
install or uninstall programs.
Lots of information is stored in each
user’s folder. Microsoft doesn’t want you
to mess around in the Users folders. It
wants you to use the libraries. For security and other reasons, it’s encouraging
the use of shortcuts in libraries.
(Continued on page 6)

More on Command.com ...
and to practice forgiveness.
— to focus on the higher qualities of the
On another subject, I found a handy
human spirit, to realize that any discom- tool, the Microsoft Fix-it Center, which is
fort we may feel is how we relate to the a free download and with your input will
subject, so we may have to look inward advise and correct many possible issues if
(Continued from page 1)

your computer is not working correctly.
Reminds me of some of the things Norton
360 might do. I hope you will all attend
our next meeting on the 25th. Until then,
be happy.

Page 6
(Continued from page 5)

Shortcuts can be put on the desktop or
the taskbar. When computers had little
memory, users were discouraged from
having lots of desktop shortcuts because
they used up memory, but with today’s
computers, the amount of memory used is
minimal. Put the shortcuts where they’re
most useful for you.
Indexing USB drives
Q: I’m using indexing in Windows 7
to speed up searches. If you have a USB
drive can it be indexed?
A: It can, but it’s not a good idea because if you remove it and conduct a
search, you’ll get unexpected results because the search won’t know that the
USB drive is no longer connected.
Music folder lists
Q: When I open My Music folder, the
column headings aren’t what I want them
to be. Can I change them? And can I
make changes apply to all folders?
A: In theory, you can make changes
universal, but it doesn’t always work.
Windows is Windows. Sometimes it has a
mind of its own. Open a folder and use
Alt+T to open the Tools menu. Open
Folder Options, click or unclick the listed
options and then click on Apply to Folders. To change the column headings, open
a folder, right click on the bar of column
names and select what you want to show.
You can adjust the order of the columns
by left clicking on a column name and
dragging it where you want it. There is no
way to create a new column name on the
list.
Removing update files
Q: I tried to update .NET, but it
wouldn’t install. I have several versions
of this. Do I need them all? And can I
delete the installation files after the updates are up and running?
A: Technically, you probably don’t
need all the versions of .NET (1, 1.1, 2, 3,
3.5 and 4), but in actuality, if you remove
the earlier ones, you’ll probably end up
breaking something.
The .NET package lets programs,
especially installers, use libraries of files
they need. Generally, a program that
needs the files installs the .NET package.
If you ever need to uninstall or reinstall
one of the programs that installed
the .NET software and you’ve removed
the installation files, you won’t be able to
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uninstall the program, which also means
you won’t be able to reinstall it to fix the
problem. Hackers figured out how to get
into version 1.1, so it was revised, but
some older programs still use it. The
same thing applies to each of the other
versions. When you have installation
problems, you should normally get an
error message with a code indicating why
it failed. Search for the code number,
.NETx (where x is the version number)
failed and you can usually find a fix-it
tool to repair the problem.
Regular Q&A
Unless otherwise noted, questions
were answered by Toby Scott. Jessica
Scott handled the computer duties.
Sharing printers
Q: I have an HP laser printer that I
want to share on a network but can’t figure out how. Right now we have to move
it back and forth and connect it to the
computer we want to print from. Could
we connect it via the router?
A: There are three kinds of printers in
general use today: wired to a computer by
USB or parallel port; connected to a network cable; and wireless.
To use the printer on a network, go to
the computer that the printer is connected
to and in Control Panel > Network and
Sharing > Change Advanced Sharing
Settings turn on File and Printer Sharing.
Then, on the same computer, go to Control Panel > Devices and Printers and
select Printer Properties > Sharing and
click on Share this printer. Give the
printer a name.
Then, on the computer the printer is
not connected to go to Control Panel >
Devices and Printers > Add a Printer and
click on Add a network, wireless or Bluetooth printer. The computer should be
able to find the printer on the network. If
it does, just select it. If it doesn’t, you can
navigate to it and click the next, next,
next, just as if you were installing a
printer.
For the share to work, both the printer
and the computer it’s connected to must
be turned on when you try to print from
the other computer.
Art Lewis: I have a printout that explains how to do this. I can send it to anyone who asks for it via email. It was developed for the AARP income tax program I work with.
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Missing DLL file
Q: When I tried to do some of this,
one of the computers is missing a DLL
file. I tried going to Lexmark and looking
for a new driver or other updates, but that
didn’t solve the problem. We discovered
that Windows 7 plug and play will work
but not the one on XP. The files were
there last year but not on this year’s computers. We have to give the computers
back to the IRS each year.
A: I’d download the drivers for the
printers for XP.
Q: I tried that and it didn’t work, but
I’ll try it again.
Printing from tablets
Q: Can you connect a tablet to the
network and print from it?
A: Yes for many tablets, but finding
the drivers for the tablet might be difficult. Not all tablets have printer support.
LPT ports
Q: A program I use requires output to
an LPT port. Is there anything that will
convert LPT input to USB?
A: There is a DOS fix: First, share the
printer and give it a share name. Then
open a Command Prompt by right mouse
clicking on it and selecting Run As Administrator. Then at a prompt, type:
net use lpt1 \\computer\printer /
persistent:yes
where computer is the name of your
computer and printer is the name you
gave your printer in the first step above.
Note that there are spaces after lpt1 and
printer.
Moving programs from XP to 7
Q: Is there a way to migrate programs
from XP to Windows 7?
A: There are programs that say they
do that, but they’re not reliable, and I
wouldn’t use them. The best solution is to
do clean installations of the programs you
use.
Public Wi-Fi
Q: If I’m on a public Wi-Fi, if I just
surf the Net and don’t use my email, am I
vulnerable in any way?
A: If you hadn’t added “in any way” I
would have said no. From a practical
standpoint, the answer is generally no, but
there’s always a possibility that you could
be hacked. Hackers are going to go after
heavy users who are going to financial
(Continued on page 7)
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sites so they can gather login information
and passwords. They’re generally not that
interested in your email or the files on
your computer. Don’t buy anything
online on a public Wi-Fi. People who
hack Starbucks’s system are looking for
the biggest possible return, and email
isn’t it. Being hacked at Starbucks could
be a first step to a takeover attempt, but
that’s generally not done on a drive-by
shooting. For that to work, you have to
install a program to make your computer
a zombie, which means you have to be
tricked into clicking on something that
starts an installation. I would not visit
password-protected financial sites or sign
into my email at a public Wi-Fi, however.
Router password
Q: I was updating my AOL email and
went into the contacts, where I seldom
look, and found the password for our
wireless router at the bottom of the list.
My daughter said she’d given the password to a visiting friend so she could use
the network, but I’m curious how it got to
the contacts list.
A: Someone put it there. It wasn’t a
computer thing. But even so, it’s not
much of a problem. If someone hacks into
your AOL account, which they’d have to
do to see it, they’re probably not going to
be sitting outside your house where they
could use your network. Your daughter
shouldn’t have put it there, and I’d delete
it, but I wouldn’t worry much about it.
CCleaner
Q: Have you had any experience with
the CCleaner software (http://
www.piriform.com)?
A: Of all the registry cleaning programs, it’s probably the best. Such programs either fix some minor problems or
they seriously break something. I don’t
think they’re useful enough to counterbalance the risks, especially if your computer is at all unusual or idiosyncratic.
They can delete entries that you need for
some obscure program or hardware and
can even make your computer unbootable. If you’re going to use a registry
cleaner, create a good backup first. They
might be helpful on an old XP machine
that is running slowly, but I wouldn’t use
them on Vista or Windows 7 machines.
There are techs who use and like them,
however.
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Computer slowing down
Q: My computer was slowing down.
The D: drive wasn’t working and was
replaced. My daughter installed a new D:
drive. She thinks it’s either a virus or a
hardware problem. I’m using a free antivirus but don’t remember which one (the
questioner later said she thinks she’s using Norton, a paid program).
A: We run into lots of machines in the
shop that are running up-to-date AVG
and Avast but still have many viruses.
Those are the two most popular free antivirus programs. If you’re using one of
them, I’d install Windows Security Essentials, which is free (http://
windows.microsoft.com/en-US/windows/
products/security-essentials). It’s probably the No. 3 anti-virus program (Norton
and Kaspersky, which are paid programs,
are the top two in no particular order).
I’d also run Malwarebytes (http://
www.malwarebytes.org). If either of the
programs won’t run or won’t install, you
need to take your machine to a shop to
get it fixed. Viruses generally block antivirus and other security programs from
being updated or installed, and the longer
you wait to get rid of the infection, the
worse it will be and the more it will cost
to repair it. Attempting to play with it
yourself won’t help and can make the
problem worse.
(The questioner said she thinks she
has Norton and has been getting messages
that it’s updating.) Norton generally updates in the background and you wouldn’t
be getting a pop-up message that it’s updating. That could be a sign a virus has
disabled it. The D: drive dying could
cause your computer to slow down. If
you’re not getting error messages after
removing the D: drive but the computer is
still slow, that points to a conclusion that
there’s a virus, but it’s impossible to diagnose with this limited description. There
could be a physical problem with the C:
drive.
Q: Would the Symantec hack have
any effects on this problem (http://
nakedsecurity.sophos.com/2012/01/25/
symantec-stop-pcanywhere/?
utm_source=Naked+Security++Sophos+List&utm_medium=email&utm
_campaign=f2702580f3-naked%
252Bsecurity)?
A: Some hackers obtained the source
code for certain Symantec programs, but
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the anti-virus program involved was the
2006 version. The code is so far out of
date it’s useless.
PC Anywhere is a problem, and the
best rule for anyone who uses it is not to
leave it running all the time. The suggestion is to turn it on only when it’s needed,
but that sometimes can’t be done for corporations that have accountants logging
in at night.
Updates and other installations
Q: Very often when I install updates, I
go through two steps. I download a file,
and when I click on it, it downloads am
additional file. Can I delete the first procured file that brought the update down
and can I throw away previous versions
of updates?
A: The first program that you get is a
downloader that gets the information to
your computer. The second is the installer. Well-behaved program will clean
up after themselves and delete TEMP
files. If you delete the installation files,
you might not be able to properly
uninstall programs or repair an installation because the necessary information is
gone. The alphabet soup folders on your
C: drive contain all that information. We
talked earlier about the .NET files. If
you’ve deleted the folder, you won’t get it
back again. If you can’t uninstall, you
can’t reinstall, and then you’re in deep
trouble.
Showing file sizes
Q: XP showed me file sizes, but Windows 7 doesn’t. Is there a way to see
them?
A: Right mouse click on the file and
go to properties, which will show the
size. Also, if you view files in Windows
Explorer in Detail mode, you can right
mouse click on the header bar (the one
that shows Name, Date Modified, Type,
etc.) and check the Size option. Then it
will show. After doing that, click Alt-T >
Folder Options > View > Apply To Folders. This should keep the settings on all
folders — but Windows has the habit of
changing folders of pictures or music
back to icons.
Q&A reminder: Please wait for the
microphone to ask, answer or comment on a question so the information
can be recorded for use in TOE.
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Program: Organizing, protecting, sharing a hard drive

Acronis products let you partition, back up
By John Weigle
jweigle@vcnet.com
rganize, Protect and
Share Your Hard
Drive” was the subject
of a webinar by Gene
Barlow at our January meeting.
Barlow, who represents Acronis True
Image and Acronis Disk Director, among
other products, has been making presentations to CIPCUG for several years. He
formerly represented PowerQuest, the
manufacturer of Partition Magic, before
the company was sold to Symantec. He
also represents, but did not discuss, Invisus Internet Protection Services, the
details of which are on his website.
Organization
In addition to files and file folders
(directories), hard drives can be organized
with partitions, Barlow said.
A partition is a specially formatted
portion of the hard drive, he said, with
each partition having its own drive letter.
The partition with the operating system is
always the C: drive. The most common
format for Windows machine hard drives
is NTFS, although the FAT 32 system is
also used on some discs.
A hard drive must have at least one
partition, which is often the entire drive,
but can have almost any number. The
drive size and the limitations on how useful very small partitions would be are the
determining factors. Computers may contain more than one hard drive, and each
of them can have additional partitions.
The C: drive is the most likely to have
problems, Barlow said, because it contains Windows and other programs,
which can be corrupted. The C: drive is
written to often as programs are added,
updated and deleted. Corrupted versions
of Windows are the most common cause
of hard drive crashes, Barlow said.
Physical failure or damage can also
cause crashes.
With today’s large hard drives —
often 500 gigabytes or more — not partitoning a drive is “like having a very large
file cabinet with just one drawer in it,”
Barlow said. Partitioning a drive also

“O

simplifies backups, he said, by separating
data files, which need to be backed up
most often, from program files, which
change less often and so don’t need to be
backed up as frequently.
Using Acronis Disk Director 11, Barlow splits his hard drives into three partitions: Programs, including Windows;
Data; and Photos, because he and his
wife, Linda, are avid photographers. Genealogists or those with other activities
that require lots of computer work might
want to create partitions for that information.
Barlow said he backs up his photo
partition without using any compression
but compresses the programs and data
partitions. That lets him preserve as much
data in each photo as possible.
Disk Director allows users to create,
delete, resize and move partitions, along
with selecting the format type, he said.
The program supports dynamic discs. The
current version works with Windows XP,
Vista and 7. It can set up Linux partitions,
but does not work on Macintosh machines, even if they can run Windows.
Flash drives probably don’t benefit from
partitions, but internal and external hard
drives do, he said.
He recommends getting one license
per household for Disk Director, uninstalling it from the computer after it’s partitioned and reinstalling it on another computer if you need to partition its drive.
True Image, discussed next, requires licenses for each computer, he said.
Protection
Regular backups are the ultimate protection, he said, because viruses can
sometimes get past anti-virus and other
anti-malware programs and damage a
drive. Barlow recommends backing up at
least once a month but more often for
some material. He compared backups to
insurance: Homeowners insurance covers
the building and its structure (comparable
to the hard drive’s operating system and
programs and all its data) while renters
insurance covers only the contents of the
home (comparable to just the data). It’s
foolish to have only renters insurance if

you own a home, he said. Backing up
only data is a similarly bad idea, he
added.
Backup types are full disk and partition (operating system, programs, data
and hard drive structure); and file (data
files only). If your hard drive crashes, the
full disk and partition backup can recreate the old drive on a reformatted or
new drive. File backups require you to
reinstall Windows and your software —
tasks that can take hours — before putting the data back.
Barlow recommends backing up to an
external hard drive rather than CDs or
DVDs because those methods are slow
and cumbersome. The external drive
should be the same size as the drive
you’re backing up or a bit larger, he said,
but it does not have to be gigantic.
Large corporations should back up
every few hours, and small business
should do so daily. For the typical home
user with a partitioned drive, he recommends a daily backup of data, a weekly
backup of less active files (the photo or
genealogy partitions he suggested), and a
monthly backup of the C: drive (operating
system and programs). He also backs up
his entire hard drive once a quarter so
he’ll have backups of any hidden partitions some manufacturers use to restore a
computer to its original configuration.
To restore a drive, you go from the
bottom of the list to the top: first the full
hard drive, second the Windows and software, third the less active files and finally
the data files. Going in this order means
that you end up with all software updates
and the latest data that was backed up.
True Image is “a lot easier to use this
year,” he said. “It’s a really delightful
package.”
The opening screen shows four tabs:
Get started; Backup and recovery; Synchronization; and Tools and utilities. The
Get started page offers tutorials on how to
back up, when to recover and sync.
The backup and recovery page shows
all the partitions on all internal and external hard drives. Two options — Back up
(Continued on page 9)

February 2012

The Outer Edge

Page 9

The Backup and recovery page of True Image 2011 shows information about all drives and partitions.
(Continued from page 8)

now and Recover — are offered for each
drive. The information for each partition
shows its location, the type of drive, a
backup schedule if one is established,
backup versions and total size.
Buyers of the CD that Barlow offers
also get a 21-page starters guide on the
CD. He suggests printing it and reading it
while taking the actions on a computer.
Other options on the Backup and recovery tab are Disk and partition backup,
Online backups, Create bootable media,
Browse for backup and Recover. After
performing a full backup, Barlow said, he
recommends incremental backups, which
copy only files that have changed since
the previous backup.
Restore
To restore a drive, Barlow said, remove the old hard drive and install the
new one. Attach the external hard drive
with your backup to the computer. Boot

the computer from a bootable CD that
you create with the program when you
install it. “In a few minutes, you will restore the hard drive to exactly what it
was.” The program copies about a gigabyte per minute, he said.
To restore individual files, attach the
external hard drive to the computer, open
Windows Explorer, which was modified
by True Image to read the backup files
when it was installed, and drag or copy
the files you want to restore to the hard
drive.
Synchronization
True Image Home 2012 is “the most
powerful backup on the market,” he said,
and this year added the synchronization
feature.
Computer owners can set up special
groups of users, whose computers will
each contain synchronization folders.
Many groups can be established, and each
group will have separate folders. A fam-

ily group might be established to let all
family members see the latest family pictures or information on family activities.
A work group could be set up to share
work-related information. And users can
even synchronize information on their
own computers — for example a desktop
and a laptop — as Barlow does when he
travels.
Each computer must have a copy of
True Image on it and, of course, must be
connected to a network or the Internet for
the synchronization to work. The program
will send new information in the folder to
the other group members quickly, but not
immediately, Barlow said. If a member’s
computer is turned off, the synchronization occurs the next time both computers
are on at the same time.
Some similar programs require online
storage to perform the synchronization,
but that’s not the case with True Image,
(Continued on page 10)
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Review: IrfanView

Free program allows picture editing, organization
By Jim Thornton
jasthorn@gmail.com
take photographs with my digital
camera, but infrequently a picture or
two have needed me to edit and
improve them by using my favorite
picture editing and enhancing tool titled
IrfanView (pronounced Ear-Fan-View).
When you first start reviewing the
pictures that you have recently taken, you
may notice that there are some color
problems. With IrfanView, you can easily
adjust color, brightness, contrast, and tint
on your pictures and do even more by
changing the depth of the colors, enhancing the colors, or swapping the colors.
Plus you can adjust the color of the background as well as adjust its brightness and
contrast. You can convert the colors to a
grayscale if you like, and if there are any
red eye problems, they are easy to remove.
It is easy to change the size of your
pictures, especially to make them smaller
for emailing. In addition, you can easily
crop and rotate your pictures. The picture
sizes range from 50x50 pixels (0.67x0.67
inches) to 600x600 pixels (8x8 inches).
Should any of your original pictures be
larger than your monitor’s screen, IrfanView will automatically reduce the picture to completely fit onto the screen.
There are additional interesting features, such as the ability to make a single
picture out of several individual pictures.
This is often used when photographing a
large landscape area and is called panorama. The extra-wide picture may be either horizontal or vertical. Another fea-

I

This is a screen shot of IrfanView with a picture from the January issue open.
ture is the ability to make and show animated GIF (Graphics Interchange Format) pictures. This is done by using a
group of pictures to make an automated
display, such as a young child dancing,
etc.
Another interesting feature is that you
can add lines, circles, arrows, and other
similar images to your picture to point out
a special or unusual item in the picture.
Another way of identifying your pictures is to add text to the picture, for example to identify the location, and/or the
people in your picture, etc. You can select
the font and size of the text that you want
to use. Other uses are to identify the date

that the picture was taken and the number
of the pictures taken at that location, etc.
Plus you can select the color of the text or
even make it transparent. Another feature
is that you can make a blank image and
add text to it and use it as the introduction
page to your slideshow.
A slideshow is a feature that is lots of
fun and very useful. It is a series of pictures shown for the time that you have set
to view each picture before the next picture appears. Another interesting feature
is to add music to your slideshow that
will play all through the slideshow. The
music needs to be from an MP3 music
(Continued on page 11)

More on hard drive protection ...
(Continued from page 9)

he said.
Barlow is working with Acronis on a
beta version of a synchronization program for Android devices, he said, but
it’s not generally available yet. He suspects similar testing is going on with the
iPad, he said.
Barlow also said Acronis offers a free
Drive Monitor, which watches disk tem-

perature, backups and critical events. If it
finds any issues, it puts a pop-up message
on the monitor. Barlow got a warning of a
critical event that the NTFS file system in
one partition was corrupted so nothing
could be backed up to it. A Microsoft
utility fixed the problem. The URL for
the program, which does not require the
installation of True Image or Disk Manager, is listed below. For those who

missed the meeting, the special prices are
available at Barlow’s User Group Relations website, the URL of which is also
listed below.
On the Net:
User Group Relations: ugr.com
Acronis: acronis.com
Acronis hard drive monitor (free):
acronis.com/homecomputing/download/
drive-monitor
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Linux Mint an up and coming contender
By Bill Wayson
bwayson@gmail.com
have mentioned in my recent
articles that the major distributions
of Linux — Ubuntu with Unity,
Fedora with Gnome 3, and
openSUSE with KDE 4, as well as others
— are each moving to
Penguin’s
significantly
new
Lair
desktop environments
that require their users to
learn new ways of using
their computers and
applications. Predictably,
much grumbling and
complaining by some
users has resulted, and
many are looking for
alternatives to their
Wayson
favorite Linux desktop.
This has created an opportunity for other
Linux distros, and some are taking
advantage of it and trying to woo those
users over to their communities. One that

I

has received a lot of attention is Linux
Mint, which offers users a more classic
desktop interface while incorporating
some of the more useful features of
Gnome. I’ll talk about the current Linux
Mint, version 12, also known as Lisa, and
why it has received so much attention.
The two primary complaints about the
recent desktop directions are that they are
much greater resource hogs than past
versions, and they require newer and
somewhat more specific hardware in
order to perform at an acceptable level;
and the new user interfaces come with a
somewhat steep learning curve, which is
annoying (at best) to anyone who just
wants the computer to work, and
specifically make it difficult to find
applications.
Linux Mint, which is a derivative of
Ubuntu, responded in recent versions by
staying with the Gnome 2 desktop. With
its current version 12, the default desktop
is Gnome 3 running underneath but with

an added layer called Mint Gnome Shell
Extensions (MGSE) running on top.
MSGE provides a more traditional
desktop experience, including the familiar
bottom panel (a top panel can be added);
an application menu with a traditional
“Start” button and hierarchical menus
presenting the installed applications,
albeit in an updated manner; a desktop
list of open windows; a task-centric
desktop (i.e. you switch between
windows, not applications); and visible
system tray icons. In short, Linux Mint 12
provides an incremental change to the
familiar computer desktop environment
that computer users will still feel
comfortable with. When pressed, the
Application Button dialog presents three
vertical columns. The left column holds
icons of favorite programs, like your Web
browser, file manager, music player, and
others. The middle column shows
multiple categories of applications, like
(Continued on page 12)

More on IrfanView ...
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file. The slideshow is best seen from a
CD that you have created.
Another slideshow device to use is a
thumb drive, also called a USB flash
drive, which can carry a large quantity of
pictures and music. A popular picture size
used on a thumb drive is 800x600 pixels
(10.67x8 inches), and, as you know, the
thumb drive is easy to carry and to use on
other computers.
IrfanView is also a music player and
plays the popular MP3 music files. There
are several other music files that it can
play: ASF, AU/SND/AIF, AVI, MID/
RMI, MOV, MP3, MPG/MPEG, WAV,
WMA and WMV. In addition to playing
music, IrfanView can play other audio
files in up to 15 audio formats. These
nonmusical audio files come from audio
CDs, numerous other devices, and many
types of sound, animation, and movie
files.
IrfanView can also display five
movie file formats, including some of the
more common graphics formats, including multiple-image icons, animated GIF

files, multipage TIF (Tag Image File)
files, and watermark image option,
IrfanView is a fast and compact image
and converter as it supports file formats
and features. IrfanView can view 26 or
more file types as well as convert and edit
these files. The more common image formats are BMP, ECW, EMF, Flash, FSH,
GIF, ICO, JP2, JPEG, JPM, LDF, LWF,
MIDI, MP3, MPEG, Ogg Vorbis, PBM,
PCX, PDF, PGM, PNG, PNGOUT, PPM,
RAW, TGA, TIFF and text files.
IrfanView has many options, and it is
nice that the program includes a large
Help feature. However, if you need more
help, it is available on the Internet. For
example, using Google, type in the
Google search box the IrfanView feature
that you need more help with, and you
will see several websites appear. In addition, on the CNET website, http://
cnettv.cnet.com/irfanview/9742-1_5350001925.html, you can view a twominute video on the features of IrfanView
after a 30-second advertisement for something else. The video is of an earlier 2007
version.

There are many other similar programs. Some of the best are Corel PaintShop Pro, Adobe Photoshop, and MGI
PhotoSuite, but IrfanView remains by far
the best one.
The program was first released in
1996, and I did a review of the program
in the July 2001 issue of TOE. The current version is 4.32, which was released
on Dec. 15, 2011, and is functional with
numerous versions of Microsoft Windows
— Windows NT, Windows 2000, Windows 98, Windows ME, Windows XP,
Windows Vista, Windows Server 2003,
and Windows 7. The downloadable program is 1,477 KB in size and is available
as freeware from www.irfanview.com for
private or noncommercial use. It’s also
available as freeware for educational use
(schools, universities, and libraries) and
for use in charity or humanitarian organizations. For use in your place of business
or for commercial purposes, the price is
$12. Kim Komando, the popular weekly
computer radio host, and PC World, a
popular computer magazine, both recommend IrfanView.
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Copyrights, Internet create a difficult conflict
By Toby Scott
tscott@scotts.net
ow that the Stop Online Piracy Act and Protect IP Act
(SOPA/PIPA) have been defeated, it is time to look at the
dynamics of the conflict between copyright holders and Internet hosts.
If a publisher creates a book, you can
do pretty much whatever you want to
with it. You cannot, however, photocopy
it and then sell the copies. This isn’t
much of a restriction as it is timeconsuming and expensive in paper and
ink to make the copies and in almost all
cases it is far easier to just buy another
copy from the copyright holder. This has
long been a precept of U.S. law.
Things changed with the advent of

N

the Internet. Now, you can copy nearly
anything and distribute it for nothing. Copyright holders are justifiably
irked that the sale of one copy of a work
can result in the work being distributed to
hundreds, thousands or even millions. What makes it even worse is that in
most cases the people making the clones
are kids. They have no money, criminal
prosecution makes the copyright holders
look like ogres and the public thinks the
copyright holders are just a bunch of
greedy slobs who want to deprive the
public of what is rightfully theirs.
So, the copyright holders are attempting to force those who have deep pockets
and control some layer of the Internet into
being their enforcement arm. This flies in
the face of current legal precedents origi-

nating with the Digital Millennium Copyright Act. The DCMA essentially provides a safe harbor for online service providers as long as they don’t deliberately
shelter copyrighted information.
SOPA/PITA was essentially an attempt to repeal the safe harbor provisions
of the DCMA. Doing so would have
made life much easier for the copyright
holders. They could go after companies
with deep pockets and force them to take
steps to remove copyrighted material —
or even prevent it from being uploaded in
the first place.
The problem with this solution, at
least as far as the online service providers
are concerned, is that they would become
(at least theoretically) liable for the publi(Continued on page 13)
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Accessories, Graphics, Office, and others
(the topmost option allows you to browse
all installed applications). Selecting one
of these categories populates the
rightmost column with just the
applications in that category, and never a
submenu.
Linux Mint further supports a
traditional desktop experience by
including MATE, which is a fork of
Gnome 2 that is compatible with Gnome
3. Mint allows the installation of both
Gnome 3 and MATE at the same time. I
suspect that many Mint users wonder why
MATE is not the default desktop
environment. Unfortunately, as the Mint
community states, MATE is not
completely stable yet and is missing a
few parts. But it is hoped that MATE will
eventually be in every way identical to
Gnome 2 and represent the future of
traditional desktops within Linux.
Clearly, the Linux Mint developers feel a
community of users loyal to the
traditional computer desktop will remain
for some time to come, and they could
very well be right.
The other areas where Linux Mint 12
shows much change from previous
versions are in the areas of artwork and

search engines. Looking down the road,
the Mint community has recently
announced a project it calls Cinnamon.
Cinnamon seeks to provide an entire
desktop environment, forked from the
Gnome 3 Shell, that will run directly on
top of Gnome 3 while retaining the
paradigms and familiarity of the Gnome 2
desktop, as opposed to MSGE, which are
just extensions to the Gnome 3 Shell. In
other words, Cinnamon is an attempt to
re-create the popular GNOME 2.x style
desktop with a GNOME 3.x engine.
With no doubt, there are many Linux
users who will follow the progress of
Linux Mint with hope that it succeeds
well.
The one area of vulnerability in the
Linux Mint road map may be the reliance
on Gnome 3, which is resource-intensive.
Some of us Linux users enjoy not being
required to upgrade our hardware every
three to five years because of the
requirements of software upgrades. But
Gnome 3 (and KDE 4.x) have imposed
this requirement for many, and we are not
particularly happy about it. Time will tell
whether or not this is a show-stopper for
more than a few of us, and I am not sure
it will be.
Linux Mint, in recent versions of its

distro, has moved to answer the call of
those who do not see a reason to abandon
the user experience that has dominated
the computer desktop for over 15 years.
Given how loud and continuous that call
has been for the past two years, I will
predict that the recent popularity enjoyed
by Linux Mint will continue and probably
grow.
Windows users may soon be able to
experience this change in desktops and
join the discussion if Microsoft succeeds
in pushing its new Metro interface to the
front of Windows 8. Now wouldn’t it be
interesting if the result was a separate
open source desktop that would run on
top of Windows 8? I won’t hold my
breath, but it would be interesting.
If you have questions or would like to
learn more about Linux and FOSS, come
to the Linux SIG meeting at 6:30 p.m.,
Tuesday, Feb. 28, at Ventura County
Computers in Ventura. We will explore
the live version of Linux Mint 12 and try
to answer any questions that are asked.
See the CIPCUG website for more
information. If you have a question or
topic you would like the Lair or Linux
SIG to cover, drop me a line at
bwayson@gmail.com.
Until next month, happy computing.
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cation of copyrighted material. Can you
imagine Facebook trying to vet every post
of every user before the rest of the public
could see it? Could Google possibly
know whether the content it indexes is
copyrighted by the owner of the site? I
host about 100 websites on my server. In
most cases, I have no idea what my customers put up on their sites. Had SOPA/
PIPA passed, we would have had to go
out of the webhosting business. We don’t
have the resources to examine the content, nor the deep pockets necessary to
fight if someone protests. And you can’t
just remove the material as soon as someone claims to be the owners and threaten
you with legal action if you don’t remove
it. People have already started making the
accusation that their work has been pirated simply to shut up viewpoints they
disagree with.
It is ironic that just about the time
SOPA/PIPA died, the Justice Department
closed down Megaupload, one of the
largest file download sites. Megaupload
allowed users to create accounts, upload
files and share them with
friends. Certainly, lots of the material on
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the site was copyrighted by others, but a
considerable amount was also family pictures, company material for sharing with
employees and other perfectly legal material. As it stands, no one who uploaded
can access their data, so someone who
thought the data was safe “in the cloud” is
without it now. It is possible some may
be able to retrieve their data, but appears
unlikely at this point.
The key here is that a lot of data at
Megaupload was perfectly legal. Undoubtedly the majority of it was
stolen copyrighted material. Not only is
the founder in jail, but several employees
are as well. It will be interesting to read
the details of the criminal trial, assuming
it happens in the U.S.
The fact that authorities were able to
coordinate an international investigation
has some believing that SOPA/PITA
were unnecessary. Others claim that
given that Megaupload was making hundreds of millions of dollars, mainly from
people distributing copyrighted material,
it is evidence that more needs to be done.
It is one thing to go after
Megaupload, where it is certain that the
bulk of the income comes from illegal

activities, but it is vastly different for
Facebook, where clearly the vast majority
of the material is not copyrighted. How
far should online service providers go to
prevent copyrighted material from being
distributed through their servers?
Perhaps more chilling is the thought
that should the U.S. force online service
providers to create software to screen
content, foreign governments could then
require them to screen content offensive
to the government. Governments already
require that they have a backdoor so they
can listen to cell phone conversations,
and they restrict search engines from indexing certain sites, so coercing online
service providers to toe the line would be
child’s play. Software that screened for
copyright would be more than powerful
enough to screen for material critical of a
government. That is, of course, if such
software could be written in the first
place. It’s not clear that it could be.
At some point, the whole concept of
copyright and fair use will have to be
revisited to take into account the technological advances that are rapidly outdating laws that were created 150 years
(Continued on page 14)

(805) 289-3960
2175 Goodyear Ave. #117 Ventura 93003

We just want to thank everyone for you patronage
VCC has decided to enter 2012 with no gimmicks,
no fancy sales pitches, no high pressure ad,
just good old fashioned full price high markup items
and expensive service rates for repairs.

Since no one buys
our sale items or believes our outlandish
sales pitches we’ve
decided to give up
and just say

“Full price every
day is our way”
So come on in
to the store
where you pay more.
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Review: Start Menu

Program lets
users revamp
Windows tool
By John Weigle
jweigle@vcnet.com
The Windows Start Menu seems to
irritate many users, even though Microsoft
provides several ways to customize it (type
customize start menu into the Windows
search to find many items covering the
topic).
Several of them were pointed out during December’s Q&A session, including
changing the size of the icons, creating flyout menus for many items and alphabetizStart Menu 7 offers users several ways to use the program.
ing the menu items.
Those who want an easier way might
want to consider Tidy Start Menu (called Start Menu 7 for Win- life easier.”
The program is easy to use. Its opening screen (above) lets
dows 7). The programs comes in two versions: free and profesyou pick the simple mode or explorer mode. The simple mode
sional, which offers additional features.
Developer Dennis Nazarenko said he wrote the program rearranges the Start menu by making flyout menus for Probecause “my Start menu used to be really huge. Once I got tired grams, My Documents, My Pictures, My Music, My Videos,
(Continued on page 15)
looking for some item in the menu and I decided to make my

Members’
classified ads

regular meeting. Otherwise,
the ad is held to the following
month.

Classified ads are free to
members. Each ad is limited Free
to 105 characters, including
spaces and to one ad per For sale
member per month. Copy has
to be to John Weigle, editor of Wanted
TOE (editor@cipcug.org),
within the week after the

Other categories

The Outer Edge is printed and prepared for mailing by:

More on copyright ...
(Continued from page 13)

ago. That's going to be exceedingly difficult. And it can’t happen until all sides have a reasonable understanding of the issues
the other sides face.
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Finally, there’s a safe way to opt out of spam
By Toby Scott
tscott@scotts.net
t wasn’t long ago that we gave the
oft-repeated advice, “Never, ever,
reply to spam asking to be taken off
the list.” The reason is that the
spammers would have confirmed that
your email address was a good one and
then sold the list to even more spammers.
But that was before the CAN-SPAM
Act (see FTC Guide at http://
business.ftc.gov/documents/bus61-CANSPAM-act-compliance-guide-business for
details). For marketers, the key details of
the CAN-SPAM Act are:
● Tell recipients where you’re located. This must include a valid postal
address (includes P.O. Box).
● Tell recipients how to opt out of
receiving future email from you.
● Honor opt-out requests promptly.
● Once people have told you they

I

don’t want to receive more messages
from you, you can’t sell or transfer their
email addresses, even in the form of a
mailing list.
If you opt out of diet, dating, finance,
cooking and other garbage-ware, you will
actually reduce the amount of spam you
are receiving.
Rick started doing this and I laughed
at him. But after two weeks he gets
hardly any spam.
With fear and trepidation, I began
doing the same, and my spam has reduced
by about two-thirds.
Oh, sure. You can’t opt out of the
Nigerian banker who wants to split the
millions one of his clients left behind
when he died. And you won’t get rid of
the Rolex watch ads that come from
China. Those don’t have any opt-out links
in them, anyway. But you will reduce the
number of U.S. solicitations, and that is

wonderful.
When you start this, you'll see multiple emails from FTD Flowers and other
vendors. You’ll think they didn’t honor
your opt-out since you keep getting the
email. But many companies license
“marketing companies” to help them with
marketing their products. It isn’t enough
to opt out of one FTD message. You have
to opt out of all the different marketing
companies’ lists. It takes time initially.
But keep after it. Before long you will
have a trickle of spam instead of a flood. I
was getting 300+ spam messages per day.
After two weeks I’m down to about 50.
Some of the lists say they need 10 days to
complete the removal process, so hopefully I’ll reduce this even further.
This article first appeared on vccomputers.com/OptOut.cfm and is reprinted
with permission. — Editor

More on Start menu ...
(Continued from page 14)

All Control Panel Items, Computer,
Desktop, Search, Run, and Help and Support. The lists are alphabetized.
You can also use several built-in
headings, such as Games and Internet,
and select the programs to put under
them. This might take a bit of experimentation as you determine what organization
plan works best for you.
As you would probably expect, all
subfolders under a heading such as My
Documents appear on the flyout menu,
and folders within folders show up as you
click on each folder.
The freeware version lets users configure the menus for all users of the PC
and hide some programs from children or
employees.
It also allows deletion of obsolete
shortcuts, among other things.
The paid version includes a Start
Menu Icon Wizard; a quick uninstall feature; a way to create your own categories;
a free subscription to new versions of the

program and priority support. The extended version costs $24.99.
“Before creating Start Menu 7 program, I’ve spent a lot of time to understand how a human brain works with visual information,” Nazarenko says on his
Web site.
“That’s why Start Menu 7 is so easy
and natural to use for everybody.”
Although I removed the program after
several weeks because the Start Menu
covered a large part of my desktop when
it was open, I can see how it would be a
big improvement for some users. Like
many things in the computer world, it’s a
matter of personal preference.
I noticed a few quirks, one of which
was that the screen location of the beginning of the open Start Menu periodically
changed for a reason I could not determine. I’m not sure if it was a result of
unknowingly clicking on something in
the menu itself, something on the desktop
— although I did not notice anything
when it happened — or some other reason.

When it’s uninstalled, the program
returns the Start Menu to its standard configuration, so there’s no danger in giving
it a test drive to see if the results are what
you want.
These sites offer some suggestions on
how to change the Start menu manually:
http://www.sevenforums.com/
tutorials/296-start-menu-all-programsadd-delete-shortcuts.html
http://www.sevenforums.com/generaldiscussion/6901-cant-re-arrange-startmenu.html
http://en.kioskea.net/faq/1244rearrange-the-menu-start
http://superuser.com/
questions/281606/windows-7automatically-rearranges-the-start-menu
After checking these sources, you
might decide it’s easier to just use the
Start Menu 7 program.
On the Net:
Home
page:
www.startmenu7.com/

http://

Be sure to keep your anti-malware programs up to date and run regular scans.
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Waiting, waiting, waiting Treasurer’s
report for
— is that site working?

I

f you’ve ever sat in front of your compuer waiting for a
website to load and wondering if your ISP is just slow, the
Internet is dying or the one site you want isn’t working,
consider bookmarking the easy-to-use website at http://
www.downforeveryoneorjustme.com.
The site has one of the easiest interfaces I’ve ever seen.
There’s an ad, and a line that asks Is google.com down for everyone or just me? Type the name of the site you want to check in
the box that cotains “google.com,” which overEditor’s
writes that name, and watch for results. You don’t
corner
have to press the Enter key. Within a second or
two you’ll get an answer to the question.
Of course, if you can’t reach the ‘Is it down …”
site or any other location on the Internet, it’s time
to start a little troubleshooting. Are your modem
and router on? Are all the connections properly
made? If you’re on DSL is your phone connection
Weigle
up and running?
If the answer to all those questions is yes, it’s
probably time to call your ISP. And while your connection is
working, it’s a good idea to go to your ISP’s website and copy
the phone numbers to contact it. You might not be able to find
them without an Internet connection.
Facebook page
I’ve said this several times, but it’s worth saying again. I’d
like to enoucrage all CIPCUG members to join our Facebook
page if you have a Facebook account. I got the first word that
Craig Ladd has confirmed two programs for this year — neither
one for February, unfortunately — through a posting at https://
www.facebook.com/groups/cipcug/. The group is open only to
CIPCUG members, which means you’ll have to ask for permission to join on your first visit. This means you’re going to reasonably safe from suffering through lots of notices about Facebook games and other irritating subjects. Several members post
links to computer-related news fairly regularly and try to respond
to questions that they know something about.
Some of you might find some of the posts too basic, while
others might find them too advanced, but I think everyone could
find some that would interest them.
Give it a try. You can always block the page or just stop going to it if you can’t find anything of interest, but I have trouble
thinking that will be the case.
What do you want to read?
Jim Thornton, who has resumed writing for TOE, periodically asks what our readers want to read. I have to respond that I
have no idea because I seldom get any responses to specific articles. Jim uses a lot of software and is reviewing it for us, but if
you have specific programs you’d like to know more about or
topics you’d like to see covered in TOE, please let me know and
I’ll pass the word along. Many thanks.
— John Weigle, editor

December 2011
By Art Lewis
treasurer@cipcug.org
12-1-2011 through
12-31-2011
Category Description
INFLOWS
Coffee income
Memberhip Income
New members 40.00
Renewals
170.00
TOTAL MEMBERSHIP
Publication sales
Raffle

Lewis

-2.75

210.00
300.00
65.00

TOTAL INFLOWS

572.25

OUTFLOWS
Corporate Expenses
Membership Expenses
Publication Purchase
Raffle prizes
Rent Paid
TOE
Uncategorized Outflows
TOTAL OUTFLOWS

26.40
17.60
10.00
96.44
150.00
268.09
0.00
568.53

OVERALL TOTAL
Unrestricted Funds
Restricted Funds
Bank Balance 12-31-11
Year to Date Income
Year to Date Expense
Net Year to Date

3.72
6,034.19
0.00
6,034.19
4,612.75
4,365.89
246.86

2012 contributors to The Outer Edge
Your name can appear here,
too. Share your knowledge with
other members by sending an article,
letters or computer tips to
editor@cipcug.org.
CIPCUG MEMBERS
Ken Church
Art Lewis
Helen Long

Diane Mortensen
Toby Scott
Michael Shalkey
Rick Smith
Jim Thornton
Bill Wayson
John Weigle
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December 2011 renewals payment due:
First
Mbr# Last Name
Pd to Dt
Name
By Ken Church
0037
Hosford
Victor
201112
email address: membership@cipcug.org
T
1115 Nagy
Marlene
201112
Welcome –
1131
Richardson
James
201112
CHURCH
New members: Needed
1048
Ulam
Frederick
201112
T
Attendance at the February 2012 general meeting:
51 members and guests
January 2012 renewals payment due:
Total membership: 189
First
Mbr# Last Name
Pd to Dt
Name
MEMBER RENEWAL INFORMATION
0926 Curry
Rick
201201
$30 for single membership,
1217
Donohue
Joseph
201201
$35 for two or more family membership.
0947 Ellis
Dick
201201
1132
Hales
Clifford
201201
NEW MEMBER INFORMATION

Membership report:

Is it time to renew?

$40 first year for single membership,
$55 first year for two or more family membership in same household.
Please send your payment to:
CIPCUG MEMBERSHIP
P.O. BOX 51354
OXNARD, CA 93031-1354
Or bring your payment to the sign in table for
the Feb. 25, 2012, meeting.

February 2012 renewals payment due:
First
Mbr# Last Name
Pd to Dt
Name
1129 Escobedo
Ray
201202
1063 Field
Dwayne
201202
1063
Field
Sharon
201202
A
0412 Guess
John
201202
1116 Hazeltine
John
201202
0843 Isaman
Harry
201202
0566 Meeker
Kirsten
201202
0565 Meeker
Mary
201202
0656
Mori
Ken
201202
T
1184 Murray
Tom
201202
1183 Norbutas
John
201202
1218 Panczel
Marika
201202
1082 Perry
Jim
201202
1232 Riggan
Lee
201202
1135 Sherbrooke
Rosalie
201202
1169 Smith
Donald
201202
1083 Stoutz
Hank
201202
1140 Wayson
Bill
201202
0130 Whelchel
Claude
201202
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Initials
BDV

Name
Bob de Violini

(805)
rjddev@gmail.com

BR

Bill Robinson

389-2997 (b)
bill@bzus.com

DM

David Minkin

469-6970 (cell);
484-2974 (home);
dddave@cipcug.org

MS

Michael Shalkey mshalkey@cipcug.org

RP

Robert Provart

498-8477 (b)

Phone: (d) = days; (e) = evenings; (b) = both

F1—Your Help Key
(Revised Sept. 7, 2008)
COMMUNICATIONS/INTERNET (GENERAL)
World Wide Web
DM
DATABASES
Access

BR

DOS

RP

E-MAIL
Outlook
Outlook Express
Thunderbird

MS
BR, DM
MS

GRAHICS PROGRAMS
IrfanView
Paint Shop Pro
Photo Shop Elements
Print Shop

MS
DM
BR
BR

SPREADSHEETS
Microsoft Excel

DM

WORD PROCESSING
Microsoft Word
WordPerfect

DM
DM

WINDOWS
Windows 98, 95
Windows 2000
Windows XP

DM, MS (98)
BDV
DM

If you would like to volunteer to help others, please send
your contact information and programs you’re willing to
help on to editor@cipcug.org.
........................
WEB HELP SITES (Updated 2-7-12)
Steve Bass TechBite Newsletter registration page:
www.techbite.com
DSL reports: www.dslreports.com
Steve Gibson: www.grc.com
Kim Komando: www.komando.com
Leo Laporte: www.leoville.com
Jeff Levy: www.jefflevy.com
Linux distributions: www.DistroWatch.com
Microsoft: www.microsoft.com
OnGuard Online: http://www.onguardonline.gov
PCMag: www.pcmag.com
PC Pitstop: www.pcpitstop.com
PC World: www.pcworld.com
Recalled products: www.recalls.gov
SANS Institute — Computer Security Education and
Information Security Training: www.sans.org
Smart Computing: www.smartcomputing.com
Spyware Warrior: www.spywarewarrior.com
User Group Relations (Gene Barlow): www.ugr.com
Ventura County Computers (Rick and Toby’s shop):
www.vccomputers.com
Virus Bulletin: www.virusbtn.com/index
Windows Secrets: www.windowssecrets.com
W i n d o ws T h e O f f i c i a l M a g a z i n e ( U K ) :
www.officialwindowsmagazine.com/

If you have a favorite help site on the Web, please forward
it, so we can expand the section. If you find a link that
doesn’t work, please tell us that, too.
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Why join Channel Islands PC Users
Group (CIPCUG)?
Every month, members of the Channel
Islands PC Users Group have access to:
♦ The Outer Edge newsletter, which
includes a list of members willing to help
other members.
♦ The general meeting, featuring a
question-and-answer session and program
on new software or hardware.
♦ Special Interest Groups — special
meetings held several times a month.
♦ Door prizes at the regular meeting.
Other benefits include:
♦ Special user group discounts on
books and software.

Dues for new members
♦ A flash drive containing many
Individual member, $40.
useful freeware programs.
Family membership (same address),
♦ A chance to make friends with
$55.
people who have similar interests.
Renewals are $30 and $35 per year
♦ The ability to put your knowledge
respectively.
to good use by helping other members.
TOE subscription only (in the U.S.),
The whole concept of user groups is
$20.
members helping members.
Please clip the coupon below and
send with payment to CIPCUGMembership, P.O. Box 51354, Oxnard,
CA 93031-1354.
Please make checks payable to
CIPCUG.

CIPCUG MEMBERSHIP
APPLICATION

CIPCUG E-MAIL ADDRESS
Members who would like to have an
e-mail address through CIPCUG in the
form of YourName@cipcug.org may obtain one for $20 per year.

User level: Novice ____; Intermediate _____;
Advanced _____

Amount enclosed: ____________________________
Please Print the following information:

Can you help the club as a volunteer? If so, what would you
be interested in working on?

Name: _______________________________________

Address: ______________________________________

City: ___________________________, State:________

Date __________________ Member # ____________
ZIP Code: _______________________________

Phone (Home): ______________(Work): ______________

E-mail address: ________________________________

The Outer Edge
Channel Islands PC Users
Group Inc.
Page 20

P.O.Box 51354
Oxnard, CA: 93031
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DUES REMINDER
If the number above your
name is 2012 FEBRUARY, your membership
dues are payable in February 2012.

February 2012 meeting
Of the Channel Islands PC Users Group
The map shows
the easiest route
to the Boys &
Girls Club, but if
you prefer, you
can take the
Carmen Drive
offramp to
Ponderosa Drive,
which leads to
Temple Avenue.

Saturday morning, Feb. 25, at the Boys &
Girls Club, 1500 Temple Ave. (Ponderosa
Drive and Temple Avenue), Camarillo.
Meeting Schedule:
8:00 a.m.
Doors open
8:45-9:30
Internet and networking SIG,
Social Media SIG
9:30-10:30
Business meeting, Q&A
10:30-11:00
Break — Please contribute requested
amounts for coffee and doughnuts
11:00-12:00
Program — TBA
Drawing

